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Electromyography
In this experiment, you will explore the electrical activity of skeletal muscle by recording an electromyogram
(EMG) from a volunteer.  You will examine the EMG of both voluntary and evoked muscle action and attempt to
measure nerve conduction velocity.

Written by staff of ADInstruments.

Background
A skeletal muscle fiber is innervated by a branch of a motor axon.  Under normal circumstances, a neuronal
action potential activates all of the muscles innervated by the motor neuron.  This activation process involves an
action potential and a contraction of the muscle fibers.  During a contraction, therefore, there is synchronous
activity in a number of fibers in the same muscle.  The electrical signal recorded from a contracting muscle is
called an electromyogram or EMG.  Like the electrocardiogram (ECG), this activity can be detected by electrodes
placed on the skin.  A voluntary muscle contraction is produced by one or more action potentials in many fibers.
The EMG activity is not a regular series of waves like the ECG, but a chaotic burst of overlapping spike-like
signals.

In this experiment, you will record EMG activity during voluntary contractions of the biceps and triceps muscles of
the arm.  The raw EMG signal during voluntary contractions may be processed in various ways to indicate the
intensity of EMG activity.  In the method used here, the negative-going portions of the EMG are inverted, and
then the whole signal is integrated in such a way as to smooth out individual spikes, and make the time course of
changing activity much clearer.  You will also record EMG signals produced by electrical stimulation of a motor
nerve supplying a muscle.  The abductor pollicis brevis muscle a member of the thenar muscle group on the
palmar surface of the hand.  The motor nerve to this muscle (the median nerve) is easy to stimulate at the wrist
and elbow.

Required Equipment
A computer system
Chart software
PowerLab  (with built-in Bio Amp or PowerLab and Bio Amp front-end)
Five-lead Shielded Bio Amp Cable & snap-connect Shielded Lead Wires
Disposable ECG recording electrodes
Stimulus Bar Electrode
Electrode cream
Abrasive pad/gel
Alcohol swabs
Ballpoint pen
Dry earth strap
Four books of similar weight (about 1 kg each)
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Warning
Some exercises involve application of electrical shocks to muscle through electrodes placed on the skin.
People who have cardiac pacemakers or who suffer from neurological or cardiac disorders should not
volunteer for those exercises.  If the volunteer feels major discomfort during the exercises, discontinue
the exercise and consult your instructor.

Subject preparation and equipment setup

1. Select a volunteer for the experiment and have that person remove any watch, jewelry, etc. from their
wrists.

2. Plug the five-lead Bio Amp cable into the Bio Amp (Figure 1).

3. Plug the lead of the dry earth strap into the Earth connection of the Bio Amp cable.  Since this cable only has
one connection pin, plug it into the upper post on the shielded Bio Amp cable (Figure 2).

Figure 1. Equipment setup for the EMG experiment, showing the connections for
recording EMG from the biceps and triceps muscles.
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Figure 2.  Attach the dry earth
strap to the upper pin on the
shielded Bio Amp cable.

4. Firmly attach the dry earth strap around the palm or wrist of the volunteer.  The fuzzy side of the dry earth
strap needs to make full contact with the skin.

5. Swab the skin with alcohol in each area where
electrodes will be placed on the volunteer (Figure 1).
With a ballpoint pen, lightly mark two small crosses on
the skin overlying the biceps muscle, in the position for
the biceps recording electrodes shown in Figure 1.  The
crosses should be 2–5 cm apart and aligned with the
long axis of the arm.  Lightly abrade the marked skin
with an abrasive pad/gel.  This decreases the resistance
of the outer skin layers and ensures good electrical
contact.

6. Prepare the skin over the triceps for attaching the
electrodes as outlined in step 5 for the biceps.  The
position for the triceps recording electrodes is shown in
Figure 1.

7. Prepare the disposable ECG electrodes by removing the backing film.  Put a small amount of electrode cream
on the pre-gelled electrode surface.  Place the electrodes onto the skin over the crosses so they adhere well.

8. Plug the four shielded lead wires into the Bio Amp cable ports for positive and negative, CH1 and CH2.

9. Snap the lead wires from Channel 1 on the Bio Amp cable onto the electrodes on the subject’s biceps.  It
does not matter which is positive and which is negative.

10. Repeat step 9 for the lead wires on Channel 2 on the Bio Amp cable onto the electrodes on the subject’s
triceps.

11. Check that all electrodes are properly connected to the volunteer and the Bio Amp cable before proceeding.

Starting the software
1. Locate Chart on the computer and start the software.  The Experiments Gallery dialog should appear.  If the

Experiments Gallery dialog does not appear in front of the Chart window, choose the Experiments Gallery…
command from the File menu.

2. From the Experiments Gallery dialog window, select Electromyography from the left-hand list.  Select
“EMG Voluntary Settings” from the right-hand list and click the Open button to apply those settings.

3. After a short time, the Chart window on the computer screen should be set up for the first exercise.  Four
channels should appear: Channels 1 and 2 show the absolute integrals of the raw EMG signals from the
muscles recorded in Channels 3 and 4.  Channel 1 should be named “∫ Biceps” (Int. Biceps, Win), Channel 2
“∫ Triceps” (Int. Triceps, Win), Channel 3 “Biceps” and Channel 4 “Triceps”.

4. Now begin the exercises.
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Exercise 1: Voluntary change in contractile force

Objectives

In this part of the laboratory, the EMG during voluntary muscle contractions will be recorded and how contractile
force changes with increasing demand will be investigated.

Procedure

1. Have the volunteer sit in a relaxed position, with their elbow bent to 90° with the palm facing upwards.  They
should use their other hand to grasp the wrist of the recorded arm.

2. Choose the Bio Amplifier… command from the Channel 3 (Biceps) Channel Function pop-up menu.

3. Ask the volunteer to make a strong contraction of the biceps muscle, by trying to bend the recording arm
further and resisting this movement with their other arm.  Observe the signal (Figure 3).

4. Adjust the value in the Range drop-down list of the Bio Amplifier dialog so that the maximal electrical
response occupies about a half to two thirds of full scale.  Click the OK button to close the dialog.

5. Repeat steps 2 to 4 for the triceps signal in Channel 4 (Triceps).  The volunteer can make a strong
contraction of the triceps muscle by trying to straighten out the recorded arm and resisting this movement
with their other arm.

6. Click Start.  Have the volunteer perform a maximum contraction of their biceps and then triceps muscles.
Click the Stop button to stop recording, and check that the integrated signal traces are clearly visible in the
Chart window. If not, adjust the Y-axis scaling so that they are visible.

7. The volunteer should once more sit in a relaxed position, with their elbow unsupported and bent to 90° with
the palm facing upwards.

8. Click Start to resume recording.  After a few seconds, place one book (or a similar weight) on the hand of the
subject.  Enter a comment in the data trace called “one book”.  Leave the book in place for two to three
seconds to record the change in the EMG, and then remove it.  Repeat this process for two, then three, then
four books, to give a series of increasing weights, adding a comment each time.

Figure 3.  The Bio Amplifier dialog showing
strong biceps contractions.
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9. Click Stop and observe the data.  The waveforms should look something like those in the Chart window in
Figure 4.

Exercise 2: Alternating activity and coactivation

Objectives

In this part of the laboratory, the activity of antagonist muscles and the phenomenon of coactivation will be
examined.

Procedure

1. The volunteer should sit in a relaxed position, with their elbow bent to 90° with the palm facing upwards.
They should use the other hand to grasp the wrist of the recording arm.

2. Ask the volunteer to activate the biceps and triceps alternately.  The biceps muscle can be activated by trying
to bend the recording arm further and resisting this movement with the other arm.  The triceps muscle can
be activated by trying to straighten out the recorded arm and resisting this movement with the other arm.
The volunteer should practice this alternating pattern until it feels like both muscles are being equally
activated in turn.

3. Click Start to begin recording.  Ask the volunteer to use the alternating pattern of activation for 20 to 30
seconds.

Figure 4.  Burst of EMG activity of bicep muscles while supporting a weight:
Channel 1 (Int. Biceps) is the integrated signal; the Zoom View shows part of
the raw EMG activity in the biceps muscle.
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4. Click the Stop button and examine the data.  The waveforms should look something like those in Figure 5.

5. Choose Save from the File menu to save the recording.

Exercise 3: Evoked EMG
Please read the following instructions through carefully before continuing with this exercise.  Note that
muscle contraction and sensations such as tingling or brief pain, are associated with nerve stimulation.

Objectives

In this exercise, EMG responses evoked by stimulating the median nerve at the wrist will be recorded.

Procedure

Continue with the same volunteer or choose a new one.  Things should be set up as described previously, with
the Bio Amp cable plugged into the Bio Amp socket on the PowerLab, and the dry earth strap wrapped around
the palm or wrist of the volunteer and connected to the Earth connection of the Bio Amp cable.

1. Disconnect the recording electrode leads from Channel 2 sockets of the Bio Amp cable, and remove their
electrodes from the triceps of the subject.  Remove the electrodes from the biceps of the subject, but leave
their leads connected to Channel 1 sockets of the Bio Amp cable.

2. To set up recording, select Experiments Gallery from the File menu and open the settings file “EMG Evoked
Settings”.  After a short time, the Chart View on the computer screen should be set up, with a single
displayed channel (Channel 3, “EMG”).

Figure 5.  A Chart recording of EMG, showing coactivation.
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3. With a ballpoint pen, lightly mark two small crosses on the skin overlying the abductor pollicis brevis muscle,
in the position for the recording electrodes shown in Figure 6. The crosses should be 2–3 cm apart.  Lightly
abrade the marked skin to reduce its electrical resistance.

4. Obtain two new disposable ECG electrodes and trim the adhesive pad slightly so they will fit as shown in
Figure 6.  Place a very small amount of electrode cream on the gelled surface of the electrode and attach
them onto the skin over the crosses.  Use adhesive tape to fasten the electrode wires immediately adjacent
to the skin electrodes.

Note:  The polarity of the electrodes must be as shown in Figure 6, with the negative electrode closer to the
wrist.

5. Connect the bar stimulus electrode to the Isolated Stimulator output of the PowerLab or Stimulus Isolator:
the red (positive) connector to the red output and the black (negative) connector to the black output.

6. Place a small amount of electrode cream on the two silver pads of the stimulating bar.

7. Place the bar stimulus electrode over the volunteer’s median nerve at the wrist (the approximate placing is
shown in Figure 6).  The bar stimulus electrode should lie along the axis of the arm, with the leads pointing
towards the hand — a red (positive) dot on the back of the electrode should be on the far end of the
electrode from the hand.  Set the stimulator switch on the PowerLab unit to the “ON” position (up).  Note
that the Isolated Stimulator only becomes active during sampling — it is switched off internally at all other
times.

Figure 6. Electrode connections for recording from the abductor
pollicis brevis muscle, and stimulation of the median nerve at the wrist
and elbow.
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8. Choose the Stimulus Isolator command (Windows) or the Stimulator command (Mac OS) from the Setup
menu to bring up the Isolated Stimulator dialog window and ensure that the settings are the same as in
Figure 7.

Note: In this exercise, Chart will record for a fixed duration of 0.05 s and then automatically stop.

9. Increase the pulse current in the Isolated Stimulator dialog to 8 mA by clicking the arrows or dragging the
slider control.  Move the Isolated Stimulator dialog to a convenient position that does not obscure the view of
the Chart View.

10. Click Start to apply a stimulus and record the response.  Apply mild pressure to the bar stimulus electrode to
ensure that the nerve is stimulated and that the electrode doesn’t move around during the exercise.  Adjust
the electrode to find the best position for stimulation.

11. If no response, increase the pulse current a little.  Some subjects may fail to show any response with the
stimulating position shown in Figure 6.  In these subjects the abductor pollicis brevis is innervated by the
ulnar nerve instead of the median nerve (an example of anatomical variation).  If so, try stimulating the ulnar
nerve.

12. From the Isolated Stimulator dialog, increase the amplitude up to 20 mA in 2 mA increments, and record the
response to a stimulus at each amplitude.

13. The responses should increase with increasing stimuli until a maximal response is reached, after which
increasing the stimulus does not further increase the response amplitude.

14. Turn the stimulator switch on the PowerLab unit off (in the down position).

15. Choose Save from the File menu to save the recording.

16. Remove the bar stimulus electrode and mark the spot in between the pressure imprints on the skin.

A. B.

Figure 7.  Isolated Stimulator dialog showing the settings for the start of Exercise 3. (A) Windows,
and (B) Mac OS.
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Exercise 4: Nerve conduction velocity

Objectives

In this exercise, nerve conduction velocity will be measured from the difference in latencies between responses
evoked by nerve stimulation at the wrist and the elbow.  This exercise should be done immediately after Exercise
3.

Procedure

1. From the File menu, choose New.  Make sure the previous data file has been saved.  Open a new blank file
with the same settings used in the previous file.  A new file should appear with a single displayed channel
(Channel 3, “EMG”).

2. Position the bar stimulus electrode on the medial aspect of the front of the elbow (Figure 6).  The electrode
requires firmer pressure at the elbow than at the wrist because the nerve is deeper in the tissues.  The
orientation of the electrode should be the same as for wrist stimulation, with the cathode (the end with the
leads) closest to the hand.

3. To set up stimulation, choose the Stimulus Isolator command (Windows) or the Stimulator command
(Mac OS) from the Setup menu.  The Isolated Stimulator dialog appears.  Set the current amplitude to 8 mA
and close the Isolated Stimulator dialog.

4. Set the stimulator switch on the front of the PowerLab to the “ON” position (up).  In Chart, click Start to
initiate a stimulus and record it.  Do this several times, using these low-amplitude pulses to help to find the
best position for the electrode.  If no response, increase the stimulus current amplitude.

5. Once the best position for the bar stimulus electrode has been found, open the Isolated Stimulator dialog
and increase the amplitude to 15–20 mA.  Close the Isolated Stimulator dialog.

6. Click Start to record a waveform.  Repeat this step three times.

7. Set the stimulator switch on the front of the PowerLab to the “OFF” position.

8. Remove the bar stimulus electrode and mark the spot in between the pressure imprints on the skin. Remove
other electrodes from the volunteer.

9. Choose Save from the File menu to save the recording.
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Analysis

Exercise 1: Voluntary change in contractile force
1. Scroll through the recorded data and note the changes in activity in the raw biceps channel (Biceps).  Note

also that placing weights on the hand gives rise to little or no activity in the triceps muscle.  Select a small
part of the “Biceps” activity and examine it in the Zoom View.  The raw EMG signal is composed of many up
and down spikes.

2. Note the relationship between the raw trace (Biceps) and integrated trace (Int. Biceps).  The height of the
integrated trace reflects the overall activity of the raw EMG signal, and gives a simpler view of the muscle’s
electrical activity.

3. Measure the amplitude of the integrated trace as weights were added and removed by using the Marker and
Waveform cursor.  The height of the trace correlates with the force produced by the muscle.  Record these
results in Table 1 of the Data Notebook.

Exercise 2: Alternating activity and coactivation
1. Scroll through the recorded data and observe the EMG traces for both the biceps and triceps.  Note the

large-scale alternation of activity in the biceps and triceps.

2. Note that when the biceps muscle is activated forcefully, there is a minor increase of activity in the triceps.
Correspondingly, there is a minor increase of activity in the biceps trace when the triceps is activated.  This
phenomenon is called “coactivation”.  Its physiological meaning is not well understood, although it perhaps
serves to stabilize the elbow joint.

3. Use the Marker and Waveform Cursor to measure and record the EMG peaks during coactivation for
biceps and triceps in Table 2 of the Data Notebook.

Exercise 3: Evoked EMG
1. Use the scroll bar at the bottom of the Chart View window to review data blocks recorded with stimulation at

the wrist.

2. Drag over a suitable waveform to select it, then choose Zoom View from the Windows menu or click the
Zoom View button in the Tool bar.  The waveforms should look something like those in Figure 8.

3. In the Zoom View, measure the latency of a single waveform in the data display area (the size of the
waveform is of no consequence).  The latency is the time elapsed from the start of the stimulus pulse — the
start of each block of data — to the start of the evoked response.  Place the Waveform Cursor at the point
where the response begins.  The latency value can then be read directly from the time display at the top of
the Zoom View.  Record the latency value in Table 3 of the Data Notebook.
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Exercise 4: Nerve Conduction Velocity
An estimate of the nerve conduction velocity is obtained from the extra time required for the nerve impulse to
reach the muscle, when stimulation is at the elbow, as compared to the wrist.

1. Measure and record the distance between the marks at the elbow and at the wrist.  This is the distance
between stimulation sites.

2. Drag in the Chart View to select a waveform and then choose Zoom View from the Window menu.  In the
Zoom View, use the same steps as outlined for wrist stimulation to measure the latency of a single
waveform. Record the latency value in Table 3 of the Data Notebook.

3. Using the conduction velocity equation given below, calculate the nerve conduction velocity of the subject:

€ 

Velocity =  Distance between stimulation sites (mm)
Difference between latencies (ms)

The units of velocity are mm/ms or, equivalently, m/s.  Record the calculation in Table 4 of the Data Notebook.

Figure 8.  A series of data blocks with EMG responses (M-waves) evoked by
median nerve stimulation at the wrist; the Zoom View shows how the
latency is measured.
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Data Notebook

Table 1. Effects of weight resistance on EMG amplitude.

Weight (or # of books) Biceps EMG amplitude (mV) Triceps EMG amplitude (mV)

Table 2. Coactivation between biceps and triceps.

Active muscle EMG amplitude in “active” muscle (mV) EMG amplitude in opposite muscle (mV)

Biceps

Triceps

Table 3. Stimulus latencies at different stimulation sites.

Stimulus Location Latency (ms)
Wrist
Elbow

Table 4. Determination of nerve conduction velocity.

Latency difference  (ms) Distance between stimulus points (mm) Nerve conduction velocity (m/sec)
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Study Questions
1. List the physiological events that occur between delivery of the stimulus and the start of the recorded

response.
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